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This user guide is provided as a means to become familiar with TRITON's software through an explanation of the
options available for manual swath editing. The user interface presented in this guide is subject to change to
accommodate software upgrades and revisions. While every precaution has been taken to eliminate errors in this
guide, TRITON assumes no responsibility for errors in this document.

Users of this document are required to have a valid license for BathyPro or Perspective in order to activate the
software. TRITON hereby grants licensees of TRITON's software the right to reproduce this document for
internal use only.
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1.0 Swath Editor Interface

Swath Editor is an add-on application for BathyPro and BathyOne which allows users to
manually edit raw soundings in XTF or GSF data files by adjusting how the sounding is
flagged for processing.

When the software is started, three windows will open: a control panel for adjusting how
the soundings are displayed and flagged; a Sweep End View swath edit window showing the
across-track section of the sounding data; and a Sweep Side View swath edit window
showing the along-track section of the sounding data.

1.1 Triton Swath Editor “"Control Panel”

The Triton Swath Editor window shown below is used for controlling the data views and
editing operations and is referred to in this document as the "Control Panel”.

There are several options available in the [ s Triton Swath Editor (=l |
control panel including: File  View Help
Beam Quality Sweep Length (pings)
> Menu Options - File, View, and Help Fonby: soam i 11 1S ooy |
¥ Good V| Overap (pings)
> Button Options - Apply, Save, Exit, Bl Okay B |10 | save |
. J| Poor Change Edits To
and Open File T o ——
> Beam Quality Display and Zoom (a)  [a] ® Bad
OpTionS [7] Mtitude Comect V] XTFping #  [¥] Side view
|::|| r‘H 5 H>> lOpenFlIe
> Sweep Length and Overlap
B XTF Pings 764 - 778
. U
» Change Edits To - Good or Bad Bathy data fle: BROGO0T XTF
Edt file: BRDGO01_2.edk
> Attitude Correct

> XTF ping #
> Side View
> Navigation Controls

> File Information Display
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1.1.1 Menu Options

There are three menus along the top of the control panel. These are: File, View and Help.

Options included in each menu are presented below.

> File:

Open: Launches browser for locating and selecting files to edit. Supported
formats include XTF and GSF files.

o Open Bathy File E
Organize = Mew folder ] @
¥ Favorites * Mame Date modified Type Size

P Desktop L edts 10/21/201012:16 ... File folder
4 Downloads |_| BRDGOOL.XTF 12/9/2010 2207 PM  XTF File 6,607 KB
"] Recent Places |_| BRDGDO2.XTF 12/9/2010 210 PM  XTF File 5,992 KB
|_| BRDGDO3.XTF 12/9/2010 211 PM  XTF File 5124 KB
Al Libraries |_| BRDGDOE.XTF 12/9/2010 213 PM  XTF File 23417 KB
[ Documents = |_| BRDGOO7 XTF 12/9/2010 213 PM  XTF File 16,690 KB
o Music |_| BRDGDO8.XTF 12/9/2010 214 PM  XTF File 16,533 KB
[E&] Pictures |_| BRDGDO3.XTF 12/9/2010 213 PM  XTF File 12,895 KB
B8 videos |_| BRDGO14.XTF 12/9/2010 220 PM  XTF File 33,402 KB
|_| BRDGD16.XTF 12/9/2010 221 PM  XTF File 24,299 KB
18 Computer |_| BRDGO17.XTF 12/9/2010 225 PM  XTF File 22,836 KB
& Local Disk (€3 | | L BRDGO18.XTF 12/9/2010 226 PM  XTF File 24,592 KB
—a Local Disk (D:) |_| BRDGO19.XTF 12/9/2010 235 PM  XTF File 19,526 KB
—a DRIVE_G (G:) |_| BRDGD20.XTF 12/9/2010 236 PM  XTF File 22,089 KB
% TritonData (\\triton-teras) (T:) || BRDGD21 XTF 12/9/2010 2:37 PM  XTF File 25,498 KB
|_| BRDGD22. XTF 12/9/2010 238 PM  XTF File 17,247 KB
€ Network |_| BRDGD23.XTF 12/9/2010 238 PM  XTF File 12,980 KB
/8 DEMOL |_| BRDGD24.XTF 12/9/2010 238 PM  XTF File 15236 KB
M HpTEST |_| BRDGD25.XTF 12/9/2010 2:40 PM  XTF File 15,528 KB
1M [-KUPRIN il || BRDGD26.XTF 12/9/2010 2:41 PM  XTF File 16,325 KB

W et
File name: - [Tlimn eXtended Format (* xtf) V]
I Open i I Cancel l

If edit files already exist for the XTF file being loaded, a second window will

open allowing the user to select which edit file to apply to the data.

ol Select an edit file to import

Organize v New folder

i Favorites
Bl Desktop
& Downloads

UEY
"= Recent Places

.~ Libraries
@ Documents

Az' Music

[E= Pictures

i Videos

B Comnuter

Name

edts

v
4] BRDGO01_0.ecit
4] BRDGOO1 1.ect

o

Date modified

10/21/201012:16 ...
12/13/201011:36 ...
12/13/201011:39 ...

Type

File folder
EDT File
EDT File

File name: | ERDENIERTT
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The window shown at the bottom of the previous page has two edit files to select
from. Please note that for this to second window to automatically open, the edit

files need to be in a subdirectory in the XTF data folder and the file name needs
to start with the raw data file name.

For this example the raw data file is called BRDG0O1 and the available edit files
are called BRDG001_0 and BRDGO01_1. If more edits are applied and saved,
they will be saved to a file automatically named BRDGOO1_2. This allows a user
to track multiple phases of swath editing.

e Save: Edits are saved to EDT files for XTF files. For GSF files, edits are saved
as adjustments to beam flags in the GSF file.

e Exit: Closes the Swath Editor
> View

e GSF History: Allows user to view GSF history when working with GSF files.
> Help

e About: Shows the software version number

1.1.2 Button Options

There are four buttons on the right side of the control panel. These are: Apply, Save,
Exit, and Open File.

> Apply: This will change the currently selected sounding either to Good or to Bad
depending upon the option selected in the 'Change Edits To' section of the control
window (see Section 1.1.5).

> Save: Edits are saved to EDT files for XTF files. For GSF files, edits are saved as
beam flag adjustments in the GSF file (same as File menu option).

» Exit: Closes the Swath Editor (same as the File menu option).

> Open File: Launches browser for locating and selecting files to edit. Supported
formats include XTF and GSF files (same as the File menu option).

\y TRITON
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1.1.3 Beam Quality Display and Zoom Options

The Beam Quality section of the control panel is used to change how the sounding data is
displayed in the editing windows based on how the sounding has been flagged. Triton's
Swath Editor recognizes four distinct beam flag types to indicate how a sounding is used
during processing. Other beam flags present in the data files are sorted into one of these
groups depending on why it was flagged. The beam flags used by Swath Editor are:

» Good - good brightness, good colinearity S
> Okay - good brightness, poor colinearity Display ~ Zoom To
> Poor - poor brightness, good colinearity B Cond S
» Bad - poor brightness, poor colinearity L
¥ Poor |C
As shown in the image to the right, the Beam Quality section has two 2 | Bad
Al | A |

columns which control how the sounding data is displayed in the
editing windows.

The column on the left are display options and indicate which type of flagged beam to
display in the editing windows. The column on the right indicates which type of flagged
beams to zoom the display to. The two images below show the same swath data in the
across-track editing window. The image on the left displays ‘Good' and 'Bad’ soundings but
is zoomed only to the 'Good' soundings, while the image to the right is zoomed to both the
'Good' and the 'Bad' soundings.

Sweep End View Sweep End View
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1.1.4 Sweep Length and Overlap
Sweep Length (pings)

These controls, shown to the right, are for managing how many pings fo 15

display in the editing windows in one frame and when advancing to the Overlap (pings)
10

next frame how many pings to overlap.

> Sweep Length (pings): this is the number of pings to display at a time in the editing
window frames. Below are two examples, the top shows only 15 pings per frame

while the bottom shows 100 pings per frame.

e
‘ Sweep Side View
|

> Overlap: indicates the number of pings to repeat. In the example above with a
Sweep Length of 15 and Overlap of 10, it would only repeat 5 pings. Assuming the
view showed pings 300 to 314, the next frame would show pings 310 to 324.

p—
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1.1.5 Change Edits To - 6ood or Bad
Change Edits To
Good
@ Bad

This will set the value to be applied to the selected soundings. If 'Bad'is
selected, clicking the Apply button in the control panel will change the
beam flag for the selected soundings to '‘Bad'.

1.1.6 Attitude Correct

Checking this box will apply attitude corrections to the soundings displayed in the editing
windows.

1.1.7 XTF ping #

Checking this box will change the ping number display from a relative numbering scheme
starting a one to the actual ping numbers in the raw data file.

1.1.8 Side View
Checking this box will open the Sweep Side View window (along-track display).

1.1.9 Navigation Controls

There are two methods for moving through the data file.

1. Near the bottom of the control panel are the following four buttons:

6o to the start of the line
Go backwards in file by the # of pings indicated in the Overlap field
Go forwards in file by the # of pings indicated in the Overlap field

Go to the end of the file

h )
A LT A ”,

2. Below the navigation buttons is a slider bar which can be dragged to any point in the
data file. A real-time read out of the file ping number allows the users to drag the
slider bar to a specific location in the file.

B ¥TF Pings 764 - 778

U
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1.1.10 File Information Display

At the bottom of the control panel is a readout of the current file loaded into the Swath

Editor and also the current edit file being used.

1.2 Swath Edit Window "Sweep End View"

A swath edit window is a dlSplCly Of ( Sweep End View

the raw sounding data which allows
the user to select individual
soundings and manually flag them as
'Bad' or '‘Good'. To the right is an
example of the Sweep End View
showing the across-track view of the
swath data.

This picture shows 100 swaths
overlapped with the red points
indicating 'Bad' soundings and the
green points indicating 'Good'

Port/Stbd Distance(m)

soundings.

1.3 Swath Edit Window "Sweep Side View"

To the right is an example of the Sweep
End View showing the across-track view
of the swath data. This picture shows the
same 100 swaths as above but along the
trackline instead.

Note that the automatic filters in the
sonar and the beam suppression filters
did not remove all of the noise from this
group of pings. Selecting the scattered
soundings in the lower part of this display
and changing their beam flags to '‘Bad’ will
improve the quality of the final grid.
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1.4 Editing Options

1.4.1 Sounding Selection
To change the beam flags of the soundings displayed in a Swath Edit Window the soundings

must be selected. There are two ways to select soundings for editing.

1. Point and Click: As it sounds, point the cursor at a sounding and click the mouse
button. When selected the point will highlight a light blue color.

2. Select by Rectangle: This option allows the user to draw a rectangle around as many
points as desired. All points selected will be highlighted.

After the points are selected, click the Apply button in the Triton Swath Editor control
panel to change the beam flags.

A couple things to note:

e Changing the beam flags does not affect the raw XTF data file. All edits are saved
to either an EDT file or to the GSF file.

e The Apply button needs to be clicked before advancing to the next set of pings.
e Using the "Del" key on your keyboard is a shortcut for the Apply button.
e You can make multiple selections before hitting Apply by holding down the CTRL key.

e Make sure to select the correct setting in the "Change Edits To" option before the
Apply button is clicked.

1.4.2 Saving Edits

When finished editing a file, select the Save button in the control panel. For XTF files,
the first time edits are saved a new subdirectory will be created (if not already there) in
the XTF data folder called "edts”. The edits will be written into a file which will
automatically be hamed the same as the edited file with an *_#" at the end. The first
time the file is edited the number will be zero and will increment for each time edits are
saved for that file. For GSF files, the edits will be written to the GSF file as changes to
the beam flags.

\y TRITON
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2.0 BathyPro Processing Workflow

When processing bathymetry data using BathyPro, manual editing of the data is performed
with the Swath Editor prior to importing the data into BathyPro. For each XTF file that is
edited an EDT file is created to be applied during the processing step.

Here is an example workflow for using the Swath Editor with BathyPro:

1. Before starting, make sure all data files to be gridded together are in the same

directory on the hard drive.

. . B eanyr
2. Launch the Swath Editor and edit each LU

file as needed.

3. When finished manual editing, launch
BathyPro and import the XTF files to
be processed by right-clicking on the
Project Files folder in the file tree and
selecting the correct file format as
shown to the right.

Project Settings Bathy Processing Volume Patchtest Windows Statistics Help

Add XTF files (Multibeam Data)...

Add XTF files (Interferometric Data)...

Add XTF files(Single Beam Data)...

Add XTF files(Single Beam from SideScan)...
Add XTF files(Auxiliary Channel]...

Add XYZ ASCI file{Multibeam Data)...

Add XYZ ASCI file(Single Beam Data]...
Add XYZ Binary file(Simrad format)...

Add XTF files (Submetrix/Simrad/5eabeam Data)...
Add XTF files (Scanning Sonar Data)...

Add XTF files (Benthos C3D)...

Add Grid File...
Delete
4. In the Select Processing window select Expand all
. ' . ' Collapse all
the bathymetry processing 'Settings
button as shown below:
. Bathymetry Correction Setti =5
A Select Processing g Dty o —
Fiaw Data Pracessings Suppress Beam uzsing Bearm Quality [~ Suppress Beam using Depth Range
[ POOR Qualit
[v Mavigation processing Settings. .. - Low uu:;;y 100.00 M ax Range ba Fishim]
v Atitude processing. @ W BAD Qualty ’T Min Fange ta Fish [m]
[¥ Bathyrnetry processing Settings. .
[ Suppress beams outside angle from nadit | -~ Suppress Beam uzsing Slant Flange
H H H . tlas angle Starboard . an alant Range |m
5. This will open the window shown o 10000 MesSiar e (i
to the right for setting the 000 | Maxangke Pert [0-1807] = e
GUTomGTed beam Suppr‘eSSion [ Suppress beams inside angle from nadic [~ Suppress Beam using gradient
filTer‘S. To Gpply manual ediTS, 0.00 Max angle Starboard LY il BTl
SCICCT _‘_he |InpUT Beam EdIT File: W e B [ Suppress beams using beamn number

checkbox.
[~ Suppress Ping using CheckSum v Input Bearn Edit Fils

6. Clle the 'Process’ bUTTOﬂ. [~ Suppress Ping on Low Range Variance

1.000 P irirrim Yariance [m”2)

\y TRITON ‘
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3.0 BathyOne Processing Workflow

When processing bathymetry data using BathyOne, manual editing of the data is
performed with the Swath Editor on GSF files after importing raw data into
PerspectiveMap and creating a DTM file. In the process of creating the DTM, BathyOne
also generates a GSF file for each input file. The advantage of using the GSF file for
processing instead of the raw XTF data file is the ability to first apply automated beam
suppression filters to the raw soundings, greatly reducing the amount of manual editing
required.

Here is an example workflow for using the Swath Editor with BathyOne:

1. Import XTF files into PerspectiveMap and use the BathyOne wizard to process the
bathymetry data.

2. Review the DTM generated in PerspectiveMap and identify areas that require
manual editing. To reduce processing time, the Swath Viewer can be used to note
the ping numbers that span the area T —
needing manual editing. The Swath Viewer j: e 4‘_
.[/| Il (06-08-1339) BRDGO26

is launched by right-clicking on a

bathymetry data file in the Navigation file

tree and selecting 'View' (shown right) or by

double clicking on the bathymetry

navigation line in the map view.

..[] | (06-08-1999) BRDGO25
-.[] Il (06-09-1999) BRDG024
[Vl (06-08-13958) BRDGO23
-] i (06-09-1999) BRDG022
..[] | (06-08-1999) BRDGO21
[Vl (06-08-1395) BRDGO20
-[] i (06-09-1999) BRDGO13
..... 71 (DR-N8-1999 BRIOGNA

Color Settings...
Show BeamLines

Process Mavigation...

Reset Mavigation

View...

3. Launch the Swath Editor and open the GSF files to be processed and save the edits
when finished. Note that the GSF files are located in a subdirectory in the DTM
folder. Each DTM file has a folder with the same name containing the GSF files.

4. When finished editing the - "
J¥] magery
GSF files using Swath Editor, i Move Down
. . . . | o Sidescan (dE) Sort by...
in PerspectiveMap right click Bathymetry — = '
. 7] o (06-09-1399) DTM_8101_L25-L26 Rebuild using..
on the DTM Iﬂyer' in the (06-09-1939) DTM_RS101_L23-124 Edit GSF using..
. 06-09-1999)
Bathymetry file tree and R I Re-merge DTM...
select 'Rebuild Using...
—
q TRITON
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A message will popup asking if you want to apply the edits in the GSF file.

Do you want to use the GSF flags that are already present in the G5F's that are
associated with the current DTMT

Selecting 'Yes' will apply the beam =
flags from the GSF file during B S

. . i On Suppress Using Beam Guality Suppress Beams Using Beam Fag
processing. The processing wizard 1 Poor [ Low [ ad @YE Ot

that will popup is the same as the
normal BathyOne processing wizard
but the beam suppression page is
limited. As shown to the right.

If you select 'No', then the edits
made to the beam flags will be
discarded and the full beam
suppression page will be available in

the processing wizard as shown
below.

Beam Suppression | Attitude Suppression

On Suppress Using Beam Quality Suppress Beams Using Gradient
[C] Poor [ Low Bad On  Max Gradient (n) 2.00

Suppress Beams Outside Angle Suppress Beams Inside Angle

Max Port 65.0

On [E] on
Max Stbd ~ 68.0

Suppress Beams Using Depth Rangs Suppress Beams Using Slant Rangs

Min Depth 0.5 Min R 10
On on in Range

Max Depth  60.0 Max Range 100.0

[ Suppress using checksum

Suppress By Beam Mumber

[E On
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